# Table of Contents

Table of Contents ................................................................. 2

Introduction ............................................................................. 3

Glossary .................................................................................. 4

Getting Started ....................................................................... 7

Standard Reports ..................................................................... 8

Navigation Overview and Diagram ......................................... 9

Using the System ..................................................................... 11

1) Using Page Slicers/Filters ... Using the Navigation Tab .......... 16
2) Using Breadcrumbs ............................................................... 16
3) Drill to another Dimension .................................................. 17
4) Drill to Detail ........................................................................ 22
5) Export to Excel ..................................................................... 29
6) Enhanced Drill Capabilities – Reporting Services ............... 34
7) “Hide and Show Only” Features... Using the Navigation Tab .... 48
8) Using the View Tab (Charts vs. Reports) ......................... 51
9) Using the Sort Tab ............................................................... 67
10) Using the Filter Tab ............................................................. 73
11) Using the Filter Tab (Rankings & Exceptions) .................... 75
12) Running your own Custom Reports – “My Views” ............... 82
Introduction

Budgetary reporting has become increasingly more important and complex, especially in these times of continued budget reductions and economic uncertainty. These challenges, coupled with the growing need for more formalized information and analysis, introduces a need for additional tools to be provided to our University System of Georgia institutions so that financial information can be reviewed and analyzed by institutional management in an expeditious and meaningful manner. While the PeopleSoft financial system is our system of record and satisfies the majority of our reporting needs, we are pleased to provide a new tool for your use. This “out of the box” product, which combines iStrategy Solutions with the ProClarity Web Reporting tool, integrated with PeopleSoft Financials, will enable intuitive self-service and analysis of institutional information through an application that is both secure and robust.

The Budgetary Reporting System framework will permit guided analysis through key performance indicators, visualization components and interactive reports and will provide consistent information and metrics to all institutional users. These reports will assist in providing insights to institutional personnel on what has occurred historically as well as information to proactively address emerging campus financial needs. The system also will provide an opportunity to use advanced analytics to provide early warning detection of budgetary trends.

We know that each of our GA First institutions has unique needs and requirements; therefore, this system provides a flexible, efficient framework to customize your reports and analysis. We believe this tool will provide an essential way in which your critical reporting needs can be supplemented and satisfied.

What is iStrategy?
iStrategy is a reporting tool provided by the Board of Regents of the University System of Georgia as an alternative to PeopleSoft Financials. iStrategy requires fewer inputs and in most cases will provide more detail than PeopleSoft Financials. iStrategy is Microsoft-based, thus the appearance is more familiar to most users than PeopleSoft Financials.

What are the benefits to iStrategy?
Both summary and detail information are available at the same place in the same system. Almost any report view in iStrategy will allow the user to “drill down” to obtain more detailed information. This includes payroll charges, accounting journals, vouchers, and purchase orders. The payroll information available is listed by person within each accounting journal.

How can I find more information?
The Board of Regents also has useful information concerning iStrategy available at http://www.usg.edu/gafirst-fin/istrategy/.

Note: You may see iStrategy referred to as a ProClarity reporting tool from time to time. These terms can be used interchangeably.
Glossary

Apply
Click this button to apply your selections to the view. When you click **Apply**, the process is run and the results are displayed.

Backspace
The “backspace” key on the computer keyboard.

Breadcrumbs (Breadcrumb Navigation)
A type of text-based web site navigation that breaks the site into links of categories and sub-categories allowing major categories of information to be linked in a range of sequential order. Breadcrumb navigation is displayed in order to see exactly where that web page is located within the web site.

Briefing Book
A view or collection of views within the reporting tool, ProClarity. When you click a library 📘, its Briefing Books 📝 replace the list of libraries. Briefing Books contain pages (reports) that can be further organized into folders.
1. In the Contents tab, open a Briefing Book by clicking its name or icon. If the Briefing Book contains folders 📝, click a folder to display its contents.
2. Click a Briefing Book page 📝. The page automatically displays in the Navigation tab.

Combine Items
Command used to aggregate the values of multiple members selected in a Background hierarchy.

Dimension
A structural attribute of a cube, which is an organized hierarchy of categories (levels) that describe data in the fact table. These categories typically describe a similar set of members upon which the user wants to base an analysis. For example, dimensions in our system include funds, departments, budget reference, vendors etc.

Drill Down/Drill Up
A technique for navigating through levels of data ranging from the most summarized (up) to the most detailed (down).

Drill Down To
The “Drill Down to” feature allows you to drill down on hierarchies that are not currently on rows or columns. For example, from a report based on Account, “Drill Down to” a further breakdown of Personal Services by Departments.
Drill to Detail
To retrieve the detailed data from which the data in a cell was summarized. For example, drill to the journal lines that make up an expense value in a cell.

Expand
An analysis feature, similar to drill down, that displays more detail about an item while maintaining the current display of other items. For example, display the individual departments that roll-up to a College node in the Department Tree.

Fact
Value or measurement, which represents a fact about the managed entity or system. In iStrategy, a Fact would consist of a Journal or a voucher while the dimensions would be the chart fields that make up the journal and/or voucher.

Export to Excel
Capability in ProClarity that enables users to export the current Briefing Book or report view to Microsoft Excel.

Hide
An analysis feature that removes selected items from the current display of data.

Library
A group of Briefing Books, each of which contain one to several reports. Security is applied to Libraries to restrict access to institution reports. The Contents tab lists all of the libraries you have permission to open.
  - To open a library, click the name of a library or its icon.

Measures
In a cube, a set of values that are usually numeric and are based on a column in the fact table of the cube. Measures are the central values that are aggregated and analyzed. Some examples of measures are Budget Amount, Encumbrance Amount, and Remaining Amount.

Member
An item in a dimension representing one or more occurrences of data. A member can be either unique or nonunique. For example, 1997 and 1998 represent unique members in the year level of a time dimension, whereas January represents nonunique members in the month level because there can be more than one January in the time dimension if it contains data for more than one year.
My Views
A special Briefing Book used to save views for personal use.

Pivot
A feature that flips data from Rows to Columns and vice versa to emphasize different comparisons.

Slice
A subset of the data in a cube, specified by limiting one or more hierarchies by members of the hierarchy. For example, facts for a particular year constitute a slice of multiyear data.

Slicer (AKA “Page Filters”)
A drop-down menu that displays with a Briefing Book page (report) and contains members (or slices of data) that can be selected to filter the data in the page. For example, a slicer could be used to select the fund on which you want the report to display data.

Tree
PeopleSoft trees are used to store Hierarchical data such as Department, GL Account hierarchy, Fund codes, etc. Trees are widely used for reporting purposes.
Getting Started

How to log in to iStrategy

The URL to log in to iStrategy is [https://frweb.usg.edu/pas](https://frweb.usg.edu/pas). When launching the web site, a pop-up box will appear and users will be prompted to enter a user ID and password. Note – Please use Internet Explorer web browser. If using IE8, make sure compatibility mode is selected (see below).

An example of a user ID is BI\JDoe. Users can obtain IDs and passwords by contacting the ITS helpdesk at 706-583-2001 or helpdesk@usg.edu.

Compatibility Mode

One of the most common helpdesk tickets that ITS receives for iStrategy is when a user runs a report in iStrategy and doesn’t get any results back. The majority of the time this issue is due to compatibility mode not being turned on. See the screen print below for an example of how to turn on compatibility mode.
Libraries, Briefing Books and Pages (Reports)

The ProClarity Tool organizes reports into Folders, Briefing Books and Libraries. The highest level, Library, will initially include a single, Standard Report Catalog. In future phases, institution specific Libraries can be added with access secured by institution to limit access to institution specific reports.

Within each Library is one to several Briefing Books. Currently there are two Briefing Books: Budget to Actuals and Procurement Reports. This manual will cover Budget to Actuals only.
Standard Reports

The following standard reports are delivered with the Budgetary Reporting System and are available to be modified and saved to “My Views”:

- Budget to Actuals - Expenditures By Acct
- Budget to Actuals - Expenditures By Dept
- Budget to Actuals - Expenditures By Fund
- Budget to Actuals - Revenues

The process of saving to “My Views” will be covered later.
Navigation Overview and Diagram

When browsing the iStrategy online system, users can select several options to review, analyze and download data. Navigating the system provides the opportunity to learn more about the features delivered.

![Diagram of iStrategy online system navigation options]

Figure 1:

1. Contents Tab – Where Institution Library and Briefing Book(s) are stored. User’s ‘My Views’ are accessed here also.
2. Navigation Tab – First tab displayed when running reports. This is where users can drill down to other dimensions on existing report data. Important note – this is the only screen where Drill Actions are available.
3. Data Layout Tab – Screen that displays the report layout as well as all criteria used by the report. This section is also used to change dimensions and measures for reports.
4. View Tab – Used to add charts and graphs to existing reports. You can also add or remove subtotals to rows and columns in this section. An important feature here is the Flatten Row Headers/Flatten Column Headers which can be used to make reports easier to view by removing multiple layers for chart fields.
5. Sort Tab – Used to sort report data based on the existing measures in the report. Preserve peer groups maintains the integrity of the tree structure within the report when sorting data.
6. Filter Tab – Provides advanced filtering options. Examples include filtering by top 5 departments over Budget.
   Note – by default all reports are set up here to Hide Empty Rows (Rows with no data using the report criteria). You can turn on/off the Hide Empty Rows and Hide Empty Columns filtering in this section.
7. Standard /or Professional Report Tool – Default access here is Standard. Only Administrators have access to Professional access. Professional access is used to develop system-wide reports.
8. My Views – Where user-specific customized reports are saved. The data contained in the ‘My Views’ reports are updated nightly just like the reports in the Institutional libraries.
9. Library – Where Institution-specific reports are accessed. Reports are typically located within briefing books that are accessed in the Libraries section.
10. Breadcrumbs - Links back to each previous page the user navigated through to get to the current page. Breadcrumbs are very useful if a user mis-clicks an item and need to navigate back to a previous screen.
Delivered Reports

Currently, all Institutions have access to a Library called ‘Standard Report Catalog’. This Catalog contains a Briefing Book called ‘Budget to Actuals’. The current delivered reports are in the screen print below. To run any of the delivered reports, select the link for the report that you would like displayed and it will typically run within a matter of seconds.

Institution Specific Libraries

Some Institutions currently have access to their own report library. This library is in addition to the ‘Standard Report Catalog’ which is available to all Institutions. The reason for these additional libraries is because the Institution may have different requirements for running the Budget to Actual reports. For example, the System Office has their own library because they may need to see the Budget to Actual data for all Institutions in one report.

UWG does not currently have its own report library.
Using the System

1. Page Filters – Used to quickly modify the report to run for different criteria. A good example of this is changing the Budget Reference to view additional fiscal years.

2. Report Body – Information that is displayed within the report.

3. Drill Down To – Very useful tool that allows users to quickly view a different dimension of the data that is currently displayed. For example, the user can select Personal Services and the Drill Down to ‘Fund’. The report would then display the Budget to Actual Personal Services account data by Fund. This can be used for other dimensions also.

4. Expand/Drill Mode
   - Expand Mode is designated by the (+) sign next to the Row values in the report. When expand mode is selected and users select the (+) sign, the row will display the next level of data based on the tree used to populate the Row in Addition to all of the current rows displayed. For example, if Personal Services is expanded then the user will see ‘Personal Services – Faculty’ as well as ‘Personal Services – Non-Faculty’. They will also still see Travel, Operating Expenses and Equipment data.
   - Drill mode is designated by the up/down arrow next to the Row values in the report. If Drill down mode is selected and the user selects ‘Personal Services’, all of the Personal Services information is displayed but the user will no longer see other report information for ‘Travel’, ‘Operating Expenses’ and ‘Equipment’.

NOTE: Figure 2 will be the reference image for exercises 1 through 7.
Available Actions when Viewing Reports

Save to My Views - When this icon is selected the user will be prompted to Name the Report and the report will then be saved in the user’s ‘My Views’ section under the Content tab. The data contained in the ‘My View’ is updated daily but the format will remain unchanged.

Print Report - When this icon is selected, user will be prompted to set up print options and can name the report if needed. Note – this option prints the current view of the report displayed in screen print above.

Export to Excel - Exports the current page to excel in spreadsheet format. The user can then re-sort and filter the report as needed as well as save the report to the user’s computer.

Email Report - When this icon is selected the user will be prompted to save the report as a my view (if not already saved). Then a link for the current report will display in the user’s e-mail client which can then be sent to other users to open. When a user selects the link to open the report they will be prompted to login with their user id and password and then the report will display as long as the user has the correct security in iStrategy.

Help - When the help icon is selected another window will display helpful information. This Help information does include an index and search tab so the user can find out more information on the desired topic. Examples include Using a Slicer, Displaying data in Charts, and Saving My Views.
Exercises

1) Using Page Slicers/Filters ... Using the Navigation Tab
   a) Run the “Budget to Actuals - Expenditures By Acct” report to display default report view.
   b) Click on Slicer/Page Filters to see list of Dimensional “slices” available in report.
   c) Select specific value from list to re-run report for selected “slice” of information.
   d) Expected Result: return data for selected slice.

2) Using Breadcrumbs
   a) Use the “Breadcrumbs to return to the Expenditures By Acct” report.
      i) Other options include the “Backspace Key” on the keyboard or the “Back” arrow in Internet Explorer.

   b) Expected Result: User will be directed back to the Budget to Actuals – Expenditures by Acct report.
3) Drill to another Dimension

Drill to another Dimension is one of the best features of iStrategy. Within just a matter of seconds users can run a report for all expenses and then quickly see what funds make up the Budget, Encumbrances and Actual amounts for Travel, for example. This can be done for any of the other dimensions also – Department, Program, etc. Below are some examples showing this functionality.

Drill to Dimension examples:

Identify row of report for Drill down to another dimension, and click on the “dimension row name” (Select: “Travel”)

a) Click on “Drill Down To…” select box in the Navigation frame to the left and select the dimension for drill down (Select: “Department - undefined”)

b) Expected Result: In this example, iStrategy would display the dollars for Travel in the new dimension of Departments.
c) You may need to click on the (+) sign next to the Row values to expand the row and see all departments. (See #4 – Expand/Drill Mode on page 13).
Use the breadcrumbs to go back to the Budget to Actuals- Expenditures by Acct report.

Note - We know that this data is for Budget Reference 2011 based on the slicer at the top of the screen. For this example, change the slicer to Budget Ref 2010 (if needed).
Identify a row of report for Drill down to another dimension, and click on the “dimension row name” (select: “Operating Expenses”)

a) Click on “Drill Down To…” select box in the Navigation frame to the left and select the dimension for drill down (Select: “Calendar Fiscal – All Fiscal Periods”)

b) Expected Result: rows will now display all Operating Expenses for Budget Ref 2010 for all Fiscal Years that make up the report data.
### Navigation

<table>
<thead>
<tr>
<th>How do I...</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get started (run a query)</td>
<td>none</td>
</tr>
<tr>
<td>Set a navigation mode?</td>
<td>none</td>
</tr>
<tr>
<td>Drill down to a specific member?</td>
<td>none</td>
</tr>
<tr>
<td>Save my page?</td>
<td>none</td>
</tr>
<tr>
<td>More help...</td>
<td>none</td>
</tr>
</tbody>
</table>

**Selected:**
- 2007

**Navigation mode:**
- Drill Down
- Show Only
- Drill Up
- Hide
- Expand

**Ordering:** 2007

**Actions:**
- none

### Table

<table>
<thead>
<tr>
<th></th>
<th>Budget</th>
<th>Open Encumb</th>
<th>Actual</th>
<th>Remaining Budget</th>
<th>Budget Utilized</th>
</tr>
</thead>
<tbody>
<tr>
<td>2007</td>
<td>16,590</td>
<td></td>
<td></td>
<td>18,500</td>
<td></td>
</tr>
<tr>
<td>2010</td>
<td>26,782,836</td>
<td>190,395</td>
<td>21,024,948</td>
<td>5,587,482</td>
<td>79.21%</td>
</tr>
<tr>
<td>2011</td>
<td>(1,363,353）</td>
<td>0</td>
<td>323,881</td>
<td>(1,867,234）</td>
<td>23.76%</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td></td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

**Grand Total:** 25,425,952 | 190,395 | 21,348,830 | 3,896,727 | 84.68%
4) Drill to Detail

Drill to detail is another very helpful tool that allows users to quickly see the data that makes up any number located within a report. It is important to understand what data can be drilled and what data cannot be drilled. Use the breadcrumbs to go back to the Budget to Actuals – Expenditures by Acct report.

In this example, all data in the Budget, Open Encum, and Actual Columns can be drilled. The data located in the Remaining Budget and Budget Utilized columns cannot be drilled. Why is this? The Remaining Budget and Budget Utilized are calculated based on the information located within the other cells. For example, to identify the Remaining Budget for the 2011 Budget Reference, a formula would be necessary: “Budget – (Open Encum + Actual) = Remaining Budget”. On the other hand, there is no formula for the Budget data. That data is made up of budget journals so we can drill on that information. If a user highlights a field in the Remaining Budget column and tries to drill on this information they will notice a couple of things. 1) The drill actions on the bottom left of the screen are empty 2) If the user selects Drill to Detail for the number they will get the error message “Error Accessing Drill To Detail Information. Remaining Budget in dimension Measures is a calculated member.”
Error Accessing Drill To Detail Information

Remaining Budget in dimension Measures is a calculated member.
The recommended approach for drilling on data is to always go down to the lowest level of detail first before drilling into the detail for the data. For example, if a user runs the Budget to Actuals – Expenditures by Dept report they see the results below. Instead of drilling on President which contains many department ID’s it is best that the user Expand the section they would like to drill using the (+) button just to the left of President and then performing their drill action based on the departments where they need more detailed information. This accomplishes a couple of things:
1) the user doesn’t have to filter through large amounts of data to get the information they want, and
2) the results come back quicker, resulting in improved performance.
Data contained within each of the Drill Actions

iStrategy is coded to know what information to provide when a user selects a certain number to drill. For example, when a user selects a number in the Budget column, only budget drill actions will be displayed. When an Encumbrance number is selected users will have the option to Drill on the Encumbrance Liquidation or they can drill on the Purchase Orders that make up the Encumbrances (if applicable). If a user selects an Actual report number, they will have the option to drill on the Journal Entry Lines or on the Voucher Lines (if applicable) that make up the journals. One customization that was done for the Voucher drills was to include the Voucher Line Payment Information (including associated Check Number) for the users reference.
Data returned when performing a Budget Drill:

[Image of a spreadsheet for Budget Drill details]

Data returned when performing an Encumbrance Liquidation Drill:

[Image of a spreadsheet for Encumbrance Liquidation details]
Data returned when performing a Purchase Order Drill:

Data returned when performing a Journal Entry Lines Drill:

Data returned when performing a Voucher Drill:
Note:

i) You can only “Drill to Detail” on stored transactional data....drill to detail cannot be performed on calculated measures such as Remaining Balance or Budget Utilized.

ii) The records selected are based on the transactional data in the report view, not measure (calculated) values.

iii) The Actions available will vary depending on data type (Budget, Open Encum, Actual)

iv) “Drill to Detail” is not the same as “Drill Down To”. “Drill to Detail” will always provide transactional data that supports the report data. “Drill Down To” will always provide the user the ability to view the data from a different perspective (ex. Show travel (6xxxxx) encumbrance data by associated Fund Codes).

v) Note: The drop-down box feature ...

   Question: “Each time I select a number a drop-down box appears. When should I use this feature?”

   Answer: “Never”. Always select the appropriate link in the “Actions” area (on the left side) for drill-down information.

“Drill Journal Entry Lines” gives all the detail that makes up the Actual number, including P-Card entries, payroll journals, etc. “Drill Voucher Lines” only gives the detail for transactions that were paid by using a Voucher in the AP system.
5) Export to Excel

All drill actions allow you to export the data to Excel. To export the data to excel, select the link at the top right of the screen (example below). The user will be prompted to either Open the file, Save the file, or Cancel the request. If the user selects open, the first time they may be prompted to confirm the file is from a trusted source. If they select ‘yes’ then the file will open in an Excel format.

Once the data is in excel, the user can sort, filter and format the data any way they prefer.
Note: In the example below, note column C displays the journal date as 00:00.0. To correct this issue, highlight the column and then right-click and select format cells. Then select 'Date' and then 'OK' and then the cells are displayed in the date format.
Date formats display date and time serial numbers as date values. Date formats that begin with an asterisk (*) respond to changes in regional date and time settings that are specified for the operating system. Formats without an asterisk are not affected by operating system settings.

<table>
<thead>
<tr>
<th>Sample</th>
<th>[Drill Budget].[Journal Date]</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type:</strong></td>
<td><em>3/14/2001</em></td>
</tr>
<tr>
<td><em>Wednesday, March 14, 2001</em></td>
<td>3/14</td>
</tr>
<tr>
<td>3/14</td>
<td>03/14/01</td>
</tr>
<tr>
<td>3/14/01</td>
<td>14-Mar</td>
</tr>
<tr>
<td>03/14/01</td>
<td>14-Mar-01</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Locale (location):</th>
<th>English (U.S.)</th>
</tr>
</thead>
</table>

[Click to OK] [Cancel]
Note:

i) Currently, the “Export to Excel” feature only loads the first 1000 rows of data. If the returned data is more than 1000 rows, select to “get all rows” of the data in the drill-down, then perform the following steps:
   (1) Select All (Ctrl + A)
   (2) Copy (Control + C)
   (3) and then open Excel and paste (Ctrl + V).

ii) You can only “Drill to Detail” on stored transactional data... “Drill to Detail” cannot be performed on calculated measures such as Remaining Balance or Budget Utilized.
iii) The records selected are based on the transactional data in the report view, not measure (calculated) values.

iv) The Actions available will vary depending on data type (Budget, Open Encumb etc.)

v) “Drill to Detail” is not the same as “Drill Down To” (See page 28, item ‘iv’ in the Note).

vi) Note: The drop-down box feature …

Question: “Each time I select a number a drop-down box appears. When should I use this feature?”

Answer: “Never”. Always select the appropriate link in the “Actions” area (on the left side) for drill-down information.

vii) “Drill Journal Entry Lines” gives all the detail that makes up the Actual number, including P-Card entries, payroll journals, etc. “Drill Voucher Lines” only gives the detail for transactions that were paid by using a Voucher in the AP system.
6) Enhanced Drill Capabilities – Reporting Services

Compared to the standard reports in the ProClarity application, the Reporting Services Tool provides a Budget Progress Report that more closely resembles the one in PeopleSoft. In ProClarity, there are restrictions that will not allow reports to run that provide All Accounts, All Departments, All Funds, All Classes, etc., side by side in a row. The Reporting Services tool is ideal for displaying data in that format. Possibly the biggest benefit of Enhanced Drills is that you can drill multiple times on some data as you will see in the examples covered in this training guide.
Enhanced drills

The examples below are taken using ABAC (57000) data but feel free to follow along using your business unit’s data here.

Run the “Budget to Actuals – Expenditures by Account Report.” Select the (+) next to the Travel category to expand the row. Select amount $269,473 and to the left side under the “Actions” section the user sees two options – 1) Drill Budget and 2) Drill Enhanced Budget. 

Note – Any time you see the word Enhanced in iStrategy it is referring to a Reporting Services Tool drill action.

Select the drill action “Drill Enhanced Budget.” The user is prompted to login again. 

(Note – This is temporary as currently the ProClarity application and the Reporting Services Tool are on two separate servers. In the near future, these applications will be on the same server and users will not have to enter ID’s and passwords multiple times).

Enter ID and password (Ex. Bi\jdoe, password). Once the password is entered the user will be directed to the Enhanced Drill for Budget.  

![ProClarity - Windows Internet Explorer](image)
## Budget Detail

**Business Unit:** (Abraham Baldwin AgriCollege)  
**Account:** (Travel-Budgetary Account)  
**Fund:** (All Funds (Share))  
**Program:** (All Programs (Share))  
**Budget Reference:** (2011 - 2011)  
**Class:** (All Clances (Share))

<table>
<thead>
<tr>
<th>Journal Id</th>
<th>Journal Date</th>
<th>Line Description</th>
<th>Budget</th>
<th>Uopost Seq</th>
<th>Ledger</th>
</tr>
</thead>
<tbody>
<tr>
<td>620100042</td>
<td>7/1/2010</td>
<td>Original from Budget Module</td>
<td>0.00</td>
<td></td>
<td>APPROP_6D</td>
</tr>
<tr>
<td>62010096</td>
<td>7/1/2010</td>
<td>Operating Supplies &amp; Expenses</td>
<td>0.00</td>
<td></td>
<td>APPROP_7D</td>
</tr>
<tr>
<td>62010026</td>
<td>7/1/2010</td>
<td>Original from Budget Module</td>
<td>0.00</td>
<td></td>
<td>APPROP_5D</td>
</tr>
<tr>
<td>62010111</td>
<td>7/1/2010</td>
<td>Original from Budget Module</td>
<td>0.00</td>
<td></td>
<td>APPROP_6D</td>
</tr>
</tbody>
</table>

Done

Logged in as: Bf\support570

Budget Reference: (2011 - 2011)  
Class: (All Clances (Share))

---

Report Viewer - Windows Internet Explorer

Account: Travel - Budgetary Account  
Fund: All Funds (Share)  
Department: No Filter on Department

Log: Show Accounting Information

Logged in as: Bf\support570
There are several key features to Note:

1) Drop-down slicers at the top of the report. Users can now run the report for all Funds or select Fund Code 10500 and just get the information for that Fund. The same goes for the Account and Department slicers.
2) Options to hide or show accounting information are available by clicking on the checkbox with the (+) or (-) signs next to the "Show Accounting Information" in the heading.

<table>
<thead>
<tr>
<th>Business Unit</th>
<th>Account Code</th>
<th>Department Id</th>
<th>Fund Code</th>
<th>Program Code</th>
<th>Budget Reference</th>
<th>Class Id</th>
<th>Project Id</th>
<th>Budget Period</th>
</tr>
</thead>
<tbody>
<tr>
<td>54000</td>
<td>90000</td>
<td>100113</td>
<td>10000</td>
<td>11100</td>
<td>2011</td>
<td>11000</td>
<td>UNSPECIFIED</td>
<td>FY 2011 Budget</td>
</tr>
<tr>
<td>54000</td>
<td>90000</td>
<td>100134</td>
<td>10000</td>
<td>11100</td>
<td>2011</td>
<td>11000</td>
<td>UNSPECIFIED</td>
<td>FY 2011 Budget</td>
</tr>
<tr>
<td>54000</td>
<td>90000</td>
<td>100134</td>
<td>10500</td>
<td>11100</td>
<td>2011</td>
<td>11000</td>
<td>UNSPECIFIED</td>
<td>FY 2011 Budget</td>
</tr>
<tr>
<td>54000</td>
<td>90000</td>
<td>1001159</td>
<td>10000</td>
<td>11100</td>
<td>2011</td>
<td>11000</td>
<td>UNSPECIFIED</td>
<td>FY 2011 Budget</td>
</tr>
<tr>
<td>54000</td>
<td>90000</td>
<td>1007000</td>
<td>10500</td>
<td>15600</td>
<td>2011</td>
<td>11000</td>
<td>UNSPECIFIED</td>
<td>FY 2011 Budget</td>
</tr>
<tr>
<td>54000</td>
<td>90000</td>
<td>1001146</td>
<td>10000</td>
<td>11100</td>
<td>2011</td>
<td>11000</td>
<td>UNSPECIFIED</td>
<td>FY 2011 Budget</td>
</tr>
</tbody>
</table>
3) Search/find functionality. If the user types the word "Offset" in the box next to the "Find" section, the reporting tool will search to find the closest line that contains the word "Offset". Also the "Next" button will show the next line where the word "Offset" is displayed. This can be really useful to find a certain Journal ID or Purchase Order.
4) Export functionality- You can export to multiple formats including PDF, Excel and Word. Select the desired format from the drop-down menu and Click on "Export."
5) Print functionality

```
<table>
<thead>
<tr>
<th>Fund Code</th>
<th>Program Code</th>
<th>Budget Reference</th>
<th>Class Field</th>
<th>Project Id</th>
<th>Period</th>
<th>Journal Id</th>
</tr>
</thead>
<tbody>
<tr>
<td>1001300</td>
<td>1000</td>
<td>11100</td>
<td>2011</td>
<td>11000</td>
<td>FY 2011 Budget</td>
<td>B20110022</td>
</tr>
<tr>
<td>0104000</td>
<td>1000</td>
<td>11100</td>
<td>2011</td>
<td>11000</td>
<td>FY 2011 Budget</td>
<td>B201100185</td>
</tr>
<tr>
<td>1046220</td>
<td>1000</td>
<td>11100</td>
<td>2011</td>
<td>11000</td>
<td>FY 2011 Budget</td>
<td>B20110048</td>
</tr>
<tr>
<td>3800000</td>
<td>1000</td>
<td>15500</td>
<td>2011</td>
<td>11000</td>
<td>FY 2011 Budget</td>
<td>B201100196</td>
</tr>
<tr>
<td>502101</td>
<td>1000</td>
<td>15300</td>
<td>2011</td>
<td>11000</td>
<td>FY 2011 Budget</td>
<td>B201100120</td>
</tr>
<tr>
<td>3001050</td>
<td>1000</td>
<td>14600</td>
<td>2011</td>
<td>11000</td>
<td>FY 2011 Budget</td>
<td>B201100193</td>
</tr>
<tr>
<td>1046223</td>
<td>1000</td>
<td>14600</td>
<td>2011</td>
<td>11000</td>
<td>FY 2011 Budget</td>
<td>B201100183</td>
</tr>
<tr>
<td>1046212</td>
<td>1000</td>
<td>14600</td>
<td>2011</td>
<td>11000</td>
<td>FY 2011 Budget</td>
<td>B201100183</td>
</tr>
<tr>
<td>1002200</td>
<td>1000</td>
<td>14700</td>
<td>2011</td>
<td>11000</td>
<td>FY 2011 Budget</td>
<td>B201100183</td>
</tr>
<tr>
<td>1032100</td>
<td>1000</td>
<td>14600</td>
<td>2011</td>
<td>11000</td>
<td>FY 2011 Budget</td>
<td>B201100183</td>
</tr>
<tr>
<td>305100</td>
<td>1000</td>
<td>14100</td>
<td>2011</td>
<td>11000</td>
<td>FY 2011 Budget</td>
<td>B201100183</td>
</tr>
</tbody>
</table>
```

Account: Travel - Budgetary Account
Fund: All Funds (Share)
Department: No Filter on Department

View Report
Closing the Reporting Services Enhanced Drill window will direct the user back to the original ProClarity report. Select an Open Encumbrance amount and then select the "Drill Enhanced Encumbrance" option.
Note – The user now has the option to select the Purchase Orders that make up the encumbrance amount and get more detail on them. For example, if the user selects PO ID 0000400822 they will be directed to another screen within reporting services that provides all of the detail around that PO, including line number, description, entered by, approved by, posted status, etc.
Closing the Reporting Services Enhanced Drill window will direct the user back to the original ProClarity report.
Select an Actual amount and then select the "Drill Enhanced Journal."
The user now has the option to do a second drill showing Payroll Information by clicking on the “Payroll Details” link.

Note – Payroll Details includes detailed payroll information by employee, so a screen print of this is not included in this training guide. Also, for Institutions who do not want this data displayed in iStrategy, ITS has the ability to secure Payroll information by hiding the payroll details link using delivered iStrategy security. This can be requested when setting up new users or updating existing users in iStrategy. Below are some of the fields available when clicking on the “Payroll Details” link.

- Transaction ID
- Employee ID
- Employee Name
- Position Number
- Account Code
- Expended Amount
- Journal Date
- Description
- Check Number

As with the other enhanced drills, all of the functionality mentioned previously (export, print, find, show accounting information) also exists for the ‘Enhanced Journal Drill’.
7) “Hide and Show Only” Features… Using the Navigation Tab
   a) Run the “Budget to Actuals - Expenditures By Dept” report to display default report view.
   b) To Isolate or Remove a Column or Row Member from the Report.
      i) Click on the **Column** or **Row Name**.
      ii) Click on the “**Show Only**” or “**Hide**” box in the Navigation frame to the left (You may get a message “The hide operation may take a long time to complete. Would you like to run the query?” Select “OK”).

   ![ProClarity - Windows Internet Explorer](image)

   **Note:** When hiding rows, grand totals will be affected. However, when hiding columns, totals will not change.
All columns and rows
iii) To “Unhide” press the “Backspace” key on your computer keyboard.

Note: This option only works once, immediately after the first change. It does not work for subsequent changes.

iv) Expected Result – selected member will be isolated or removed from the report.
8) **Using the View Tab (Charts vs. Reports)**

   a) Run the “Budget to Actuals - Expenditures By Fund” report to display default report view.

   b) Click on the **View** tab (**Figure 1, Page 9 - #4**).

   c) Select the type of view “**Grid and Chart**” in the View frame to the left.

   **Note** – Users have the option to select Grid only (Default view) or Chart only also.
d) Select the type of chart “Pie chart”

e) Expected Result: report will redisplay in selected view type
Let's customize this report. In this example, we would like to see the Actual Expenditures by all Funds for Budget Reference 2010 in a Horizontal Bar Chart. It is important to note that all iStrategy functionality in this training guide applies to charts as well as grid reports.

f) Select the "Actual" Column in the report and select "Show only". Expected results are below.
g) Select the "Education and General" row and select "Show only". Expected results are below.
- Export a grid to Excel
- Display grand totals and subtotals
- Open the Decomposition Tree
- Display data in a chart
- Flatten grid row or column headers
- More help...

Grid Options

Totals
- Column Grand Totals
- Column Subtotals

Chart Options

- Grid only
- Grid and Chart
- Chart only

Chart Types

- Bar chart
- Bar chart (horizontal)
- Line chart
- Area chart
- Point chart
- Pie chart

Budget References: 2010 - 2018
Business Unit: 57000 - Abraham Baldwin Agri College
Department: All Departments

<table>
<thead>
<tr>
<th>Education &amp; General</th>
<th>Actual</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grand Total</td>
<td>21,266,105</td>
</tr>
<tr>
<td>Education &amp; General</td>
<td>21,266,105</td>
</tr>
</tbody>
</table>
h) Click on the (+) Symbol to the left of "Education and General." Expected results—All Education and General Funds will be displayed in the grid report and reflected in the Chart. Expected results are below.

- Export a grid to Excel
- Display grand totals and subtotals
- Open the Decomposition Tree
- Display data in a chart
- Flatten grid row or column headers
- More help...

III

Grid only

Grid and Chart

Chart only

Bar chart

Bar chart (horizontal)

Line chart

Area chart

Point chart

Pie chart

Grid Options

Totals

Column Grand Totals

Column Subtotals

Expand Education & General
• Export a grid to Excel
• Display grand totals and subtotals
• Open the Decomposition Tree
• Display data in a chart
• Flatten grid row or column headers

Grid Options
Totals
0 Column Grand Totals
0 Column Subtotals

Grid Options
0 Grid only
0 Grid and Chart
0 Chart only

How do I...
• Export a grid to Excel>
• Display grand totals and subtotals>
• Open the Decomposition Tree>
• Display data in a chart>
• Flatten grid row or column headers>
• Learn help...

Bar chart
Bar chart (horizontal)
Line chart
Area chart
Point chart
Pie chart

Education & General
10000 - State Appropriations
10500 - Tuition
10500 - Other General
10900 - State Approp-Federa

Education & General
Actual
10000 - State Appropriations 11,206,404
10500 - Tuition 6,513,192
10500 - Other General 1,246,194
10900 - State Approp-Federal Stimulus 2,298,234
Grand Total 21,266,105
i) Optional — User has the option to remove the Column Grand Totals by unchecking the check box to the left of the "Column Grand Totals" in the Grid Options section. By default, iStrategy will always display the Column Grand Totals for this report.
j) **Note** that the chart still shows “Education and General” as well as the Fund codes that make up the Education and General Fund. In this example, we don’t want to see the “Education and General” heading. To remove the heading, highlight “Education and General” and select “Hide”.

![Image of chart with option to hide Education and General](image-url)

**Note** – The user may be prompted with a screen that lets them know this operation may take a long time. If this displays, select “OK”. This operation should not take more than a couple of seconds.
k) The Fund data is now displayed in the Grid and Chart. Use the slicer at the top to change the "Budget Reference" to 2009. Expected results—the Grid and Chart data changes accordingly to the Budget Reference selected.
ProClarity - Windows Internet Explorer

How do I...
- Export a grid to Excel
- Display grand totals and subtotals
- Open the Decomposition Tree
- Display data in a chart
- Flatten grid row or column headers
- More help...

Grid Options
Totals
- Column Grand Totals
- Column Subtotals

View
- Grid only
- Grid and Chart
- Chart only
- Bar chart
- Bar chart (horizontal)
- Line chart
- Area chart
- Point chart
- Pie chart

Grid Options
- Actual
- 10000 - State Appropriations 13,841,822
- 10500 - Tuition 6,194,862
- 10600 - Other General 1,155,341
- 10900 - State Appropriations-Federal Stimulus 142,814

Department: All Departments
Budget References: 2009 - 2009
Business Unit: 57000 - Abraham Baldwin Agr Coll Level 02
To view this chart as a Bar Chart (Horizontal), select the "Bar Chart (Horizontal)" option. Expected result—the chart should display as a Horizontal Bar Chart. See below.
m) Now that we have the report looking exactly like we want it, we are going to save the report and chart to "My Views" by selecting the 'Save this page to my views' icon to the top-right of the report screen. Expected results-User will be prompted to save the report and can then access the report from their "My Views" section any time in the future.
9) Using the Sort Tab
   a) Run the “Budget to Actuals – Expenditures By Dept” report to display default report view.
   b) Click on the (+) sign to the left of one of the departments until you reach the department id level. Example: President
   c) Click on the Sort tab (Figure 1, Page 9 - #5).
   d) Select the column for sorting in the Sort frame to the left (drop-down menu -select “Budget”).
      Note – Users will not see any of the sort options until after they select an option from the “Sort” drop-down box. Once a sort option is selected then the user will have the option to select how they would like to sort the report data.
   e) Select High to Low, or Low to High.
   f) Click on “Apply”.
   g) Expected Result: Rows will be sorted based on the column and options selected.
The report is now sorted by Budget from highest budget to lowest budget.
To maintain the integrity of the tree structure (President and all departments that roll up to President) check the box to the left of "Preserve Peer Groups" and re-click the "Apply" button.
Expected results are below.

<table>
<thead>
<tr>
<th>Business Unit</th>
<th>2010 - 2010</th>
<th>Budget</th>
<th>Open Encumb</th>
<th>Actual</th>
<th>Remaining Budget</th>
<th>Budget L</th>
</tr>
</thead>
<tbody>
<tr>
<td>57000 - Abraham Baldwin Apple College</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VP Fiscal Affairs</td>
<td>18,920,198</td>
<td>179,947</td>
<td>17,383,765</td>
<td>1,567,365</td>
<td>8</td>
<td></td>
</tr>
<tr>
<td>VP Academic Affairs</td>
<td>12,523,127</td>
<td>0</td>
<td>12,278,569</td>
<td>242,618</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>Director of Human Resources</td>
<td>9,519,815</td>
<td>0</td>
<td>7,215,673</td>
<td>2,302,142</td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>Director of Inst Technology</td>
<td>1,623,028</td>
<td>0</td>
<td>1,521,765</td>
<td>101,243</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>Enrollment Services</td>
<td>1,378,763</td>
<td>0</td>
<td>1,377,960</td>
<td>83</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>External Affairs</td>
<td>1,365,188</td>
<td>0</td>
<td>1,232,455</td>
<td>132,733</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>VP Student Affairs</td>
<td>1,241,399</td>
<td>0</td>
<td>1,081,768</td>
<td>159,631</td>
<td>8</td>
<td></td>
</tr>
<tr>
<td>Director of Athletics</td>
<td>551,316</td>
<td>0</td>
<td>427,588</td>
<td>123,728</td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>Not in Hierarchy</td>
<td>390,929</td>
<td>11,348</td>
<td>485,223</td>
<td>(105,843)</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>President</td>
<td>288,503</td>
<td>0</td>
<td>288,503</td>
<td>0</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>President's Office</td>
<td>288,503</td>
<td>0</td>
<td>288,503</td>
<td>0</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>5000112 - Ambassadors Gen/Admin</td>
<td>209,503</td>
<td>0</td>
<td>209,503</td>
<td>0</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Director of Public Relations</td>
<td>279,535</td>
<td>0</td>
<td>279,635</td>
<td>0</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Admin and Operations</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Development</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Grand Total</td>
<td>47,780,891</td>
<td>198,395</td>
<td>43,574,824</td>
<td>4,015,672</td>
<td>5</td>
<td></td>
</tr>
</tbody>
</table>
h) To remove the sorting, select "No Sort" from the Sort drop-down menu and click "Apply."
Expected results are below.

<table>
<thead>
<tr>
<th>Budget Reference</th>
<th>President</th>
<th>Open Encumb</th>
<th>Actual</th>
<th>Remaining Budget</th>
<th>Budget Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>2010 - 2019</td>
<td>288,503</td>
<td>0</td>
<td>288,503</td>
<td>0</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>President</td>
<td>288,503</td>
<td>0</td>
<td>288,503</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>President</td>
<td>288,503</td>
<td>0</td>
<td>288,503</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>4000100 - President's Office</td>
<td>288,503</td>
<td>0</td>
<td>288,503</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>5800112 - Ambassadors Gen/Admin</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Admin and Operations</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Director of Public Relations</td>
<td>276,636</td>
<td>0</td>
<td>276,636</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Development</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>External Affairs</td>
<td>1,385,188</td>
<td>0</td>
<td>1,232,456</td>
<td>132,733</td>
</tr>
<tr>
<td></td>
<td>Enrollment Services</td>
<td>1,378,753</td>
<td>0</td>
<td>1,377,900</td>
<td>853</td>
</tr>
<tr>
<td></td>
<td>Director of Inst Technology</td>
<td>1,623,028</td>
<td>0</td>
<td>1,521,785</td>
<td>101,243</td>
</tr>
<tr>
<td></td>
<td>VP Academic Affairs</td>
<td>12,525,127</td>
<td>0</td>
<td>12,279,509</td>
<td>243,618</td>
</tr>
<tr>
<td></td>
<td>Director of Athletics</td>
<td>551,316</td>
<td>0</td>
<td>427,898</td>
<td>123,728</td>
</tr>
<tr>
<td></td>
<td>VP Fiscal Affairs</td>
<td>18,620,198</td>
<td>179,947</td>
<td>17,383,786</td>
<td>1,057,386</td>
</tr>
<tr>
<td></td>
<td>Director of Human Resources</td>
<td>9,518,816</td>
<td>0</td>
<td>7,216,673</td>
<td>2,302,142</td>
</tr>
<tr>
<td></td>
<td>VP Student Affairs</td>
<td>1,241,399</td>
<td>0</td>
<td>1,081,788</td>
<td>159,611</td>
</tr>
<tr>
<td></td>
<td>Not in Hierarchy</td>
<td>390,929</td>
<td>11,348</td>
<td>405,223</td>
<td>(105,643)</td>
</tr>
<tr>
<td><strong>Grand Total</strong></td>
<td>47,790,894</td>
<td>190,395</td>
<td>43,574,824</td>
<td>4,815,672</td>
<td>8</td>
</tr>
</tbody>
</table>

[Table image of ProClarity analysis server showing budget references and values for different departments]
10) Using the Filter Tab

By default, iStrategy will hide all empty rows on the Budget to Actual reports. In this example, there are fund codes that do not have any data against them for the criteria used in this report. Uncheck the check box next to “Hide Empty Rows” to show all funds regardless of whether there are any journal entries against those funds or not. As one could imagine, this could get pretty sticky and impact performance if we were to show all values for certain chart fields (ex. Acct, dept).

a) Run the “Budget to Actuals - Revenues” report to display default report view
b) Click on Filter tab (Figure 1, Page 9 - #6)
c) Uncheck the “Hide Empty Rows” box and select “Apply”. Note – The apply button is grayed out until the user selects the checkbox to change the Hide Empty Rows/Hide Empty Columns criteria. Expected Result: report will redisplay with Empty Rows and/or Columns unhidden.
11) Using the Filter Tab (Rankings & Exceptions)
   a) Run the “Budget to Actuals - Expenditures by Department” report to display default report view.
   b) Change the Budget Reference slicer to view 2010 data
c) Click on the **Filter** tab (Figure 1, Page 9 - #6)

d) Click on **Filter 1** and select a filter type “**Top**”. The filter is based on two general filter types:

i) Top and Bottom are relative selections or rankings (i.e., select the top/bottom x members or % of members based on criteria).

ii) Above, Below and Between are absolute criteria for selection

iii) Once you select the filter type, you will be able to select more criteria for the filter
e) Select the “based on” dimension in the drop-down box. The drop-down box contains all the options for filters. Select “Budget”.

**Note:** Use the scroll bar to view the entire drop-down list.
f) By default, iStrategy is going to display the top 5. This value can be changed to display other amounts (i.e. 10, 20). When the filter criteria is complete, click the “Apply” button. Expected results – the report displays the top 5 Departments based on Budget.

i) The “for” section is not used

ii) Count, sum, and % filters are also available as options in the drop-down box. This example uses a Top 5 Count.
To filter the report by Remaining Budget instead of Budget, change the report filter criteria “based on” option to “Remaining Budget” and click the “Apply” button.

Now that the data is filtered, the user has the option of adding a second filter (sub-filter) if they prefer.

g) To add second criteria, select Filter 2. To show only the filtered lines that have Actual amounts Greater than 10,000,000, use the following criteria for filter 2
   i) Actual above 10,000,000
<table>
<thead>
<tr>
<th>Riter 1</th>
<th>Filter:</th>
<th>Show rows</th>
<th>Remaining Budget</th>
<th>for</th>
<th>in the top 5 count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Riter 2</td>
<td>Filter:</td>
<td>Show rows</td>
<td>Actual</td>
<td>is above 10000000</td>
<td></td>
</tr>
</tbody>
</table>

**Budget Reference:** 2010 - 2011

<table>
<thead>
<tr>
<th>Business Unit</th>
<th>57000 - Abraham Baldwin Agri College</th>
</tr>
</thead>
<tbody>
<tr>
<td>Director of Human Resources</td>
<td>Budget: 9,510,816</td>
</tr>
<tr>
<td>VP Fiscal Affairs</td>
<td>18,620,168</td>
</tr>
<tr>
<td>VP Academic Affairs</td>
<td>12,523,127</td>
</tr>
<tr>
<td>VP Student Affairs</td>
<td>1,241,399</td>
</tr>
<tr>
<td>External Affairs</td>
<td>1,306,168</td>
</tr>
</tbody>
</table>

**Grand Total:** 43,268,727 | 179,047 | 39,194,190 | 3,895,490 | 91.00%
h) Click the **"Apply"** button to run the report

i) Expected Result: Report will be redisplayed with data based on the filter criteria.

![Report Image]

---

**Filter**

<table>
<thead>
<tr>
<th>Filter</th>
<th>Show rows</th>
<th>Based on</th>
<th>For</th>
<th>In the top</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter 1</td>
<td></td>
<td>Remaining Budget</td>
<td></td>
<td>5</td>
</tr>
<tr>
<td>Filter 2</td>
<td>Above</td>
<td>Actual</td>
<td>is above</td>
<td>10000000</td>
</tr>
</tbody>
</table>

**Table**

<table>
<thead>
<tr>
<th></th>
<th>Budget</th>
<th>Open Encumb</th>
<th>Actual</th>
<th>Remaining Budget</th>
<th>Budget Utilized</th>
</tr>
</thead>
<tbody>
<tr>
<td>VP Fiscal Affairs</td>
<td>18,520,198</td>
<td>179,047</td>
<td>17,383,788</td>
<td>1,967,366</td>
<td>94.22%</td>
</tr>
<tr>
<td>VP Academic Affairs</td>
<td>12,523,127</td>
<td>0</td>
<td>12,279,509</td>
<td>243,618</td>
<td>95.05%</td>
</tr>
<tr>
<td><strong>Grand Total</strong></td>
<td>31,113,325</td>
<td>179,047</td>
<td>29,663,294</td>
<td>1,000,984</td>
<td>95.02%</td>
</tr>
</tbody>
</table>
12) Running your own Custom Reports – “My Views”

On page 66 of the training guide the user is prompted to save a report to their “My Views” section.

As a final exercise, please complete the steps below to access your “My Views” section.

Note - The data contained in “My Views” reports is updated nightly just like the reports in the Institutional libraries.

To List and Run “My Views” Reports.

a) Click on the Contents tab (Figure 1, Page 9 - #1).
b) Click on “My Views” (located next to Libraries) (Figure 1, Page 9 - #8).
c) Click on the report name in “My Views” to run (Figure 1, Page 9 - #9).
d) Expected result - The "My Views" report runs correctly showing the report created earlier.
Conclusion:

This Executive Training guide has covered navigating the iStrategy system, running basic reports, using slicers/filters, using breadcrumbs, drilling to other dimensions, drilling to underlying detail data, enhanced drill options, how trees are used in iStrategy, exporting data to excel, hiding rows/columns, sorting data, creating charts, filtering data and saving reports to “My Views”.

**NOTE:** This training guide is a pre-requisite to the “Budgetary Reporting System for Power Users” class. The Power User Guide will contain more information about reporting methodology, customizing reports, changing dimensions, and creating slicers.